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Guide Intro

Version 1.00

About the guide
Welcome to the Vectorworks Style Guide. This guide has been written to provide guidelines for content creators to make Vectorworks (VW) 

content in a consistent manner. This includes Vectorworks object symbols that represent manufacturer products such as furnishings, 

sanitary fixtures, lighting, etc. Other types of Vectorworks resources will also be covered.

Vectorworks software is constantly being updated and improved; therefore the workflows in this guide will need to be updated to keep up 

with those changes.

This guide assumes you already have some understanding of Vectorworks, and it is not meant for training on features and topics that can 

be found within the Vectorworks Help system. 

You can access a wide range of tutorials in Vectorworks University. Anyone can create a free Vectorworks account to access our Customer 

Portal. Once you are signed on to the Customer Portal you can:

Access our free Vectorworks University Training. 

Getting Started: The Basics

See the Vectorworks Libraries highlighted in the Customer Portal.

You will find the actual Vectorworks Libraries within the software in the Resource Manager palette.

Who is this guide for?

This guide will focus on how to create content for parties adding content to the application, as well as those providing content to their own 

customers via, manufacturer product pages, BIM hosting sites, or other types of content hosting. 

It will also provide insight and comparison on how Vectorworks develops some of it resources for inclusion with the application and how we 

recommend 3rd parties to proceed.

Please note this guide does not cover every type of Vectorworks resource content creation. Certain development is outside the scope 

of this guide or may need to be done by Vectorworks developers internally.

Training and tutorials in Vectorworks University Vectorworks Libraries

https://university.vectorworks.net/mod/scorm/player.php?scoid=24&cm=92&currentorg=articulate_rise
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Disclaimer
We know that not everyone will agree with this guide. But this is how we set up content in Vectorworks to allow for content use across 

the multiple industries that Vectorworks design products serve, and allows it to work within many factors such as, limitations in plug-ins 

and features, product delivery limitations, regional needs, and trying to accommodate hundreds of third parties/manufacturers, and our 

own internal demands, while striking a balance of available time and resources to develop the Vectorworks application content.

Therefore Vectorworks cannot be held liable if something does not work based on the information provided in this guide, or if it cannot 

accommodate every individual's unique usage and needs. 

This guide should be used as a baseline in understanding how Vectorworks creates the application content. It is up to you to draw your own 

conclusions on what works best in your situation. 

In fact, this guide is the same guide that Vectorworks own, content developers use, and we have modified it to be usable to outside parties 

so there is one single source of information internally which can be shared for use with our partners and others wanting to know how to go 

about making CAD/BIM content. 

What are Vectorworks resources vs. content?

Most of the content supplied with the Vectorworks application is known as the Vectorworks resources, which can include symbol definitions, 

textures, plugin object styles (parametric), hatches, images, and others. The resources are part of the overall content. Content can also be 

included within data and settings throughout the application.

These collections of resources are referred to as the Vectorworks Libraries that are included with the software. A Vectorworks library file will 

contain one or more resources. All of the Vectorworks resource Libraries are accessible through the Resource Manager. This is a large 

palette that shows the resources provided within the application, as well as custom-made resource content, and the content in the open 

Vectorworks documents.

 As you look at the Resource Manager you will notice that there are two primary groups:

Premium Libraries - These are the libraries that are exclusive to our customers in the Vectorworks Service Select program.

Most of the new libraries are first introduced through the Service Select program. These libraries remain exclusive for about a year. 

Then those libraries are moved over into the Vectorworks Libraries at which time they are no longer “exclusive”. 

Vectorworks Libraries - These libraries are available to all users of the current software. This is where the majority of the library files 

reside.

The Resource Manager displaying a symbol library.
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What standards is Vectorworks using?

Vectorworks English international products are used throughout the world. Therefore, we have developed most of our content to not follow a 

particular standard. When there is certain content that is standardized for a market, we will typically state it. But typically, we do not follow a 

specific government standard or international industry standard because there is not one true standard across the world and content may be 

used across multiple industries with different standards.

How is it presented?

This guide will provide instructions for 3rd parties, content creators that wish to develop their own Vectorworks version content. Throughout 

the guide we will also state how Vectorworks develops it for the application, so if you are working with us to add to the application you can 

see the differences from what we recommend as a simpler solution to those who are not adding partner content directly to Vectorworks. 

When there are these comparisons, it will be identified with an emoji as follows:

This guide will eventually include other sections to focus on different workflows and best practices. It is strongly suggested to start with the 

Basic guide before following any specialized workflows that are eventually added.

Partner Program
If you are using this guide and are a product manufacturer or similar 3rd party you may have already worked with us. As a part of that, 

Vectorworks provides a Data Consent Agreement for those that wish to include their branded content within the software. Once the library is 

provided to our users we can also add your company to our Partner’s page.

Vectorworks developers

The Vectorworks logo indicates how Vectorworks development makes the library 

content. This is how it should be done if the resource library is being included with 

the software.

Content creators

The bullseye and dart indicate information that is more beneficial for content 

creators and will usually offer a simpler alternative than what Vectorworks' 

developers will follow. If you are making resources to be hosted on a 3rd party 

website, you can use the methods marked with this emoji. 

If your intent is to create content that will eventually be added to the to the 

Vectorworks application, you will need to follow the Vectorworks developers 

instruction.
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Partner Network page.

https://www.vectorworks.net/en-US/community/partner-network
https://www.vectorworks.net/community/partner-network
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Basic Guide

As mentioned in the Intro section there are many types of Vectorworks resources. One of the main types we will discuss are the symbols. A 

Vectorworks symbol is a container that usually has an object in it.

Vectorworks objects can be either a 2D object, 3D object, or a 3D/Hybrid. A 3D/Hybrid possesses both a 3D object (model) and a 2D object 

(planar geometry). The 3D can be made to represent a highly detailed model, and the 2D can be more simplistic for achieving a plan view or 

more schematic look.

Another resource type is textures. These resources can include rendering shaders or image maps. The textures can then be applied to a 3D 

object. Often these textures will be found in the symbol libraries providing more realistic rendering results rather than just rendering the 

symbol using its fill color. Many times, the texture is nested (or a child) within the symbol.  

In the Basic Guide we will explain these two resources as it pertains to creating your library and some of the  aspects to consider.

Please read this guide first. This first guide goes over the common aspects you need to consider in creating your resource. This 

information should be understood before going to the other guides (future release) that cover more specific instructions.
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Planning the Library
Getting started
For consistency you should always begin files with latest ‘Blank (Imperial).sta’ or ‘Blank (Metric).sta’ template provided in the Vectorworks 

application. This will ensure that you have optimal settings applied to the document by its developers.

File setup

Turn off Use at Creation on the ‘None’ class

After starting a file with the Blank (Imp).vwx or Blank (Metric).vwx template you should edit the 'None' class. 

Begin the new library by selecting: File > New… > then select the 

“Use document template” radio button and pick one of the 

aforementioned templates. 

Symbol geometry should typically have the texture setting set to ‘None’ if no texture is to be applied, on the Render tab on the Object 

Info palette. This is by default set to “Class Texture” on the Render tab when objects are created. To change this, edit the class you 

are working on and uncheck “Use at Creation”.
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Turn off Save VGM graphics cache

Turn ‘Save VGM graphics cache’ off for development. Default library templates will have this “on”. Turning this off is necessary to keep the 

file size smaller. Otherwise, all graphics are saved within the file making the file too large.

Planning the library
Vectorworks files can contain numerous resources to represent all the products from a company, or one product line from a manufacturer, or 

it can just represent only one product.

Internally at Vectorworks, we will make the libraries contain many products for a manufacturer as long as it makes sense in it being 

presentable without making the files too large. If there are many products and it can’t be reasonably contained in a single file, the products 

are split into individual files for each product line or set of related products.

Here are some considerations for planning your library.

Presentation and aesthetics 
Consistency across the libraries, especially within the same subject is important for the user to have an easy to follow browsing 

experience as they look through the libraries.

Aesthetics are also important for the “look” and presentation of the content.

The structure of the content and how it will appear adjacent to other files/folders and the subject matter all contribute to part of the 

presentation.

File structure and size

File size should be considered when planning the library and the way it is structured will affect that. Below are some basic considerations. 

This topic will also be mentioned elsewhere, as more aspects of creating the content are explained.

File size

       Vectorworks developed library files included with the application are generally around 25 to 50 MB or less, although there are 

exceptions. We try to stay in that range so software users with slow connections do not need to wait a longer time when downloading a 

library file through our Resource Manager.

File > Document Preferences
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 If you are hosting the content yourself, it is up to you to decide on the maximum file size you prefer. Keep in mind download time for 

large files. By making the resources smaller in size inside the file, it will make the file smaller and allow smoother operation in user’s 

documents when combined with many other objects.

File structure

:ve: Vectorworks develops most libraries as collections of the same type of VW resource, such as libraries of symbols or textures.

The symbols are the largest type of VW resource that are made in the VW Libraries. These are mostly organized as either generic or 

branded products in one or more files, typically of the same subject.

If we develop a manufacturer’s entire catalog of products into VW symbols, and all those products fit within the 25 to 50 mb range, we only 

need to make one file.

If it will be larger than that, multiple files are needed. We can make each file represent a product line or each file represent a category of 

products.

Here are some examples:

In the image on the left below, an entire collection of generic fitness equipment symbols is contained within one file.

Similarly, a single file can contain all the products from a manufacturer’s catalog if there are not a lot of products and the file size can be 

a reasonable size.

If it is a larger catalog of products, then create multiple files to include each product line as a separate file. See the image below on the 

right.

Or if it is a larger catalog of products, then similar objects of the same subject (e.g. Kohler Kitchen Sinks.vwx) can be assembled as a 

file.

Another option is to match the structure of the original source file. For example, a single file can be used to mimic a Revit Family file’s 

structure with each of the Revit Family types made into a VW symbol in the new VW file. We will sometimes do this when we want to create 

one file per product. We will only do this when it is being added to a manufacturer’s individual product page for the file to be hosted on a 

manufacturer’s web site.

 If you are an individual Content Creator this may not apply or be needed. If you are building larger collections, you may have your own 

method in place. Or if converting from another format, you may wish to duplicate that source's structure. 

Naming files

 For Manufacturers and Content Hosting Sites - We will cover the specific naming in each of the workflows in future BIM and 

Entertainment Guides.

Generic subject example

This is an example of a generic (non-branded) library file by subject 

that Vectorworks has made.

 Manufacturer product line example

This is an example of a branded product line file that Vectorworks 

has made.
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:ve: Internally Vectorworks has a deeper explanation for variables associated with file naming and the file and folder organization to work as 

a cumulative system within the Resource Manager for the multiple industries we support. This is beyond the scope of this guide. 

Units - metric or imperial - does it matter?

A Vectorworks file’s Document Settings will require a Unit of metric or imperial to be set. You may want to pick the unit your source 

information is provided in then model from there. 

Most of the libraries Vectorworks provides are meant to be usable in either metric or imperial unless otherwise indicated within the folder or 

file name as presented in Vectorworks libraries. Although a unit does need to be set for the developer to create the resources, it is generally 

meant to be usable in either unit.

Just be aware that metric units will not just convert to an even imperial measurement (by changing the document unit) when it is opened.
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Symbol Resources
Symbols are the most common resources we develop. The symbols act as containers that store and hold the geometry within the Resource 

Manager palette in Vectorworks. 

Symbol types
In Vectorworks symbols can contain the following geometry.

2D only - Geometry is only 2D planar.

3D only - Geometry is only 3D.

3D/Hybrid - Contains both 3D objects, along with 2D objects specifically for Top/Plan view. This is the most common type of symbol 

developed in the Vectorworks Libraries. 

Symbol colors
The symbols have categories which is indicated by its color. The table below explains the four types and behavior. 

 The Vectorworks Help provides a more in depth explanation on the symbols types by following this link 

Vectorworks Help - Symbols

BIM Architectural - Symbol Types

Black Static symbol that has instances created when placed 

into the document. Editing the symbol affects all the 

other instances.

Container for geometry, text, or 

other objects. This is the most 

common symbol type used.

Blue Group symbol that will convert to group when placed in 

the document and will no longer be an instance. 

Anything attached to the symbol container will be lost 

such as record formats and Resource Manager tags.

Used to have a group of products 

assembled or arranged together 

for placement. This is rarely used.

Red Created from plugin and/or converts to a plugin when 

placed into the document. In most cases these are 

styles associated and created from a plugin such as, 

Door, Hardscape, etc.

Container for plugin 

configurations.

Green Page based symbol typically for annotation/title blocks 

only

Typically, only for use on Sheet 

Layers.

Type Description Use

https://app-help.vectorworks.net/current/eng/index.htm?rhmapid=w_ConceptSymbols
https://www.youtube.com/watch?v=YSws9dDKLu4
https://www.youtube.com/watch?v=YSws9dDKLu4
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2D for Symbols
In this section we will show the rules for making the 2D geometry and text (when needed) as it pertains to symbols.

Most 2D plan geometry should be an accurately sized representation of a subject. It should be a simplified version of what is modeled in a 

3D model when it is part of a hybrid symbol. Although certain symbols such as diagrammatic symbols (e.g. electrical diagram symbols) 

would be excluded from having an accurate scale. 

The sections below will provide guidelines for making this 2D geometry.

2D planar line work
 Use of multiple pen thicknesses is optional, as we know this further complicates conversion to Vectorworks format. It is also subjective. 

If you only use one pen thickness weight in 2D, please use 0.13mm/5mils.

:ve:  If you are developing libraries to be delivered with the software, it must have pen line thickness. 

Use only the default pen thicknesses. The same thicknesses should be used throughout the library to give a uniform look.

In the 2D linework the smallest default pen thickness (0.05mm) should not be used, because it doesn't always print accurately on certain 

printers. We use 0.13mm as the finest line size in 2D.

The line thickness may need to vary sometimes depending on the size and the scale at which it will typically be used.

Small objects like faucets cannot have a 7mils (0.18mm) outline or the outline will dominate the appearance of the object at a typical 

design layer’s scale.

Geometry should be constructed with as few connected lines as possible instead of many segmented lines.

Using arcs instead of segmented lines will produce more efficient geometry for “curved” linework.

Geometry should be constructed with as few polygon objects as possible.

Dashed lines should typically use the ISO 02 Dashed line types for the BIM/AEC content. Although additional line types will be used 

when needed.

Spotlight generally uses ISO 03 Dashed line type.

2D Linework for Top/Plan view

Object Contours 3/8 5 0.13

Defines edges 1/2 7 0.18

Outline of object 3/4 10 0.25

Lines for Points Mils mm
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2D object fills
2D plan symbols need to have a solid polygon fill background that usually encompasses the entire perimeter of the geometry and 

obscures objects under it.

The interior line work will usually not have any fill as it is mostly used to provide contours and form within the solid polygon. 

Creating 2D geometry for 3D/Hybrid symbols
Vectorworks Inc, typically makes its symbols as 3D/Hybrids. This is a symbol containing both a 3D model and 2D plan view. The 2D view is 

generally simpler than the detail that is present on the 3D model. 

This is also discussed in the next sections on 3D Symbols and 3D/Hybrids and Symbol Options.

Here are some methods to consider when you want to provide a 2D plan view like those found in most 3D/Hybrid symbols of the 

Vectorworks Libraries.

Method 1 - Create from 3D object 

:ve: This is the Vectorworks, Inc. preferred method.

When creating a matching 2D representation of a 3D object, like for making Hybrid objects, this option can be used. 

1. From the Resource Manager (RM) right click on the 3D symbol and select “Edit 2D Components…”

2. From the Component Edit palette, on the “Show Other” dropdown select “3D.”

3. Right click on the 3D object and select, ”Generate 2D Graphics from 3D component” and select 'Hidden Line Rendering.”

4. This will produce the 2D polygons. These polygons can be cleaned up and simplified for inclusion in the Vectorworks Libraries.

This will result in:

All geometry being grouped together.

The outer geometry polygon shape with a 0.18mm line thickness.

The inner linework geometry will be set to 0.13mm line thickness.

There will be extraneous linework after running the command that will need to be removed and checked for overlapping lines.

Any segmented lines should be further checked for, then run Modify>Compose command on the segmented lines wherever possible.

With the object selected, select the Level of detail: Show Detail All Levels checked on the Object Info Palette.

Turn on Zoom Line Thickness to check that the pen thickness will be appropriate for the object size and typical layer scales it could 

be used for.

2D Top in the Component Edit palette.
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Method 2 - Auto Hybrid

Use the Create Auto Hybrid command feature from a 3D model in Vectorworks. 

:ve: This is not used by Vectorworks, Inc. when developing the symbols libraries, but is an option for a quick 2D planar object representing 

the model. Please consult the Vectorworks Help system by searching, “Creating auto hybrid objects” for more information on adding an Auto 

Hybrid.

For more information you can also watch this live session recording on Auto Hybrid, from Vectorworks University.

Method 3 - No 2D

You could forego including 2D geometry altogether in the symbols and it will only be a 3D only symbol. This is the least optimal solution for 

content that will be included in the Vectorworks Libraries.

:ve:  Vectorworks will include a 2D component in almost all cases to produce a 3D/Hybrid symbol.

 This is up to the 3rd party content creators when it is not included in Vectorworks.

For the 2D sides, front, back, …

Repeat one of the above methods to also create “Generate 2D from 3D component…” in Vectorworks if this is needed.

:ve: Vectorworks developers only add the front, sides and back to the plumbing fixtures in the Vectorworks Libraries.

 This is up to the 3rd party content creators.

Text font usage in symbols
Text is sometimes included on certain 2D objects in symbols. Furthermore, it may be used to differentiate the same 2D geometry used on 

more than one hybrid symbol.

:ve: We recommend to always use Arial fonts. Vectorworks is Mac and Windows compatible, and one system may have fonts that are not 

present on the other platform system. Therefore, we only use the Arial font for text in Vectorworks resources and labeling, as it is a common 

font. There are font mapping issues created when a Mac only font is opened in Windows and vice versa presenting a Font Mapping dialog 

when first opening the file when the font is not present on another computer.

Grouping and structure
When constructing your 2D geometry (and if not using Auto Hybrid) you should think about making the geometry easy to edit by someone 

wishing to do so when they use the symbol. The symbol structure should be organized so that similar objects are grouped together. 

Typically objects that are all the same color are usually grouped together so the color can be changed for all of those objects at once, 

instead of having to select numerous individual objects to edit.  

Created by Vectorworks • Updated on Sep 12, 2018

You’ve made the move to working in 3D. Now, optimize that effort by efficiently creating 2D
drawings from your 3D and BIM models. With the new 2D components for hybrid objects
capability, we’re putting you in complete control of the detail level your symbols and plug-in…

YouTube Open preview

Please do not use the VW company font, DIN Pro, in the library files. That is reserved for company use in emails and marketing 

materials.

2D Components for Hybrid Objects

https://university.vectorworks.net/mod/page/view.php?id=571
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Example of 2D grouping for easy fill color changes.
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3D Symbols
In most cases the 3D component of a symbol will contain a 3D model. A 3D/Hybrid symbol also contains a 2D planar component like a plan 

view of the object. A Vectorworks symbol is essentially a container that holds 3D geometry, image props (2D image in 3D space), plug-in 

styles, etc. 

In this section we will only discuss developing the 3D geometry and considerations. Other topics like image props and styles will not be 

addressed at this time.

3D geometry in symbols
The 3D geometry models should be presented accurately. They should provide enough detail to be able to distinguish them from other 

models in the category but not with so much detail that they represent a perfect physical model of the source item; that makes them too 

large to be usable.

You will find that some imported models (especially DWG, 3ds) may need to be simplified if extremely detailed and too large. 

Line work
Use only the default pen thickness. The same thicknesses should be used throughout the library to give a uniform look.

The pen style should be the smallest size since line weight is generally not a factor for the 3D models.

Pen and fill color

The pen color and fill background should be identical for 3D geometry.  This excludes objects with white fill, which should have black 

pen.

Like materials should be the same color and grouped together.

If a texture is applied, make the pen and fill color similar to the texture’s overall color.

All 3D models should look aesthetically pleasing when rendered in Shaded rendering mode, whether or not textures are attached. 

Structure and grouping

The symbol structure should be organized so that similar objects are grouped together. As with 2D, objects that are the same color, are 

usually grouped together. This is so the color can be changed for all the objects at once, instead of the users having to select numerous 

individual objects.

Structure for texturing

If a symbol is to have a single texture applied to the entire model in the symbol, then all the geometry should be a single piece or 

grouped before applying the texture. This could be for a single mesh or group of meshes. Solids should be combined if they will have a 

single texture applied.

If the symbol geometry is to have multiple textures, the geometry should be organized into separate components, so that each texture 

can be applied to a single piece of geometry.

Pen color and Background fill
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Grouping 

Nesting symbols 

Some symbols may share the same parts. By making that geometry into symbols that represent those parts, it can be shared as nested 

instances of those symbols in multiple parent symbols. Using nested symbols like this can reduce the overall file size of the library by 

eliminating the duplication of parts. If an edit needs to be made on the shared part, all parents symbols will benefit from that update. 

 Texture creation is discussed later in this guide.

Original imported geometry and remodeled solid in Wireframe

Model parts can be grouped within the symbol, and it can be 

beneficial for easier editing to have related geometry together, 

especially in complex models. This is something that should be 

considered when constructing models.

In this example, more complex models like this vehicle are made up 

of many components. Each component is a single mesh, with 

matching fill and pen color, and has a single texture applied. All the 

individual components (meshes) are then grouped together.

Exploded view showing geometry groups
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The example above shows a library of transit stops. Many of the same parts are placed as instances that are grouped within the parent 

symbols. These arrangements of nested symbols produces the overall model(s). This library is much smaller using these instances than it 

would be if each part was just repeated geometry.

Scaling symbols

We do not recommend the scaling of symbols. This can lead to potential issues especially when the symbols are used in certain 

Vectorworks plugins. It is best to create unique and accurate sized geometry within symbols.

Modeling in Vectorworks
You will either need to create new models or convert another format to Vectorworks format by importing models into your file. Here we will 

go over the model creation portion, and make some recommendations.

If no 3D models are available then starting with a good 2D source may be the best option to start the building of your models. This can be 

from references like photographs, technical drawings, imported raster files, PDF specification sheets, and imported 2D CAD files including 

those from other formats, etc.

Using image sources

If no other source is available, images can be used by importing them into Vectorworks. Then scale the image(s) to a size that is accurate, 

and then trace out the form to begin creating the required 2D and 3D shapes. 

BMP, JPEG, PNG and TIFF are all image/raster formats that can be imported into Vectorworks and placed on the Design Layer and used as 

reference to model from. See the Help for other formats supported.

Using existing 2D geometry

If only 2D CAD files exist, then these sources can be used as a “template” to trace from when modeling your 3D shapes. 

Extrusions can be created from the 2D objects, and other 3D operations can be “snapped” to the 2D geometry to begin modeling.

Using 3D modeling features in Vectorworks 

Obviously, in order to model from scratch or from 2D source in Vectorworks, you will need to use the Vectorworks modeling features. We will 

not go into all the 3D modeling methods. But you should consult our online Help and training that is available through Vectorworks University 

to learn these methods and techniques. 

Here are some common geometry operations you should consider. 

Parent symbols using nested parts from the folder Nested Symbol Part folder contents

See also the Vectorworks Help section on, Collaboration > Importing files, for more thorough details on importing files. 

Extrudes - create simple extrudes Push/Pull Tool
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Create simpler 3D objects with direct texture mapping

Another method when building from scratch or simplifying is to make simpler geometry forms, and then apply images to these to represent 

more detailed areas. 

This can be done with direct texture mapping. This allows the use of a simpler 3D model that then has had an image applied to replace very 

detailed part that would otherwise need to be modeled. You can see in the images below that these simple models define the overall shape 

of the kiosk or device, and they then have a texture applied for the detailed areas of the screens and controls. 

Geometry types - considerations

When either creating models from scratch, or reviewing imported geometry results from another CAD format, you should consider the type 

of geometry being used and your options. 

In the table below are some basic considerations of 3D geometry that is often used in Vectorworks models. Also shown are the preferences 

on some of this geometry when we construct our libraries. More on these geometry types will be mentioned in the next section on Importing.

Primitive shapes

Use Sweeps

Use Sweeps along a path

Subdivision tool

Loft Surface

Shell Solid Tool

Fillet Edge Tool

Chamfer Edge Tool

3D Power Pack menu items

Consult the Vectorworks Help section on, Creating objects > 3D Modeling. This will provide you with explanations on the many 

modeling techniques.    Vectorworks Help - 3D Modeling  

Kiosks with direct texture mapping applied Credit Card device with image 
texture keypad and screen

See also the Vectorworks Help section on, Applying and mapping textures > Direct texture mapping, for more thorough details 

on importing files.   Vectorworks Help - Direct texture mapping 

Solids geometry

Produces a smaller file size and quicker rendering, but requires a lot 

of modeling time. More complex shapes are more difficult to make but 

the mathematical accuracy is greater. Most of the parametric plug-ins 

are solid operations.

 Preferred

NURBS  Preferred

Geometry type Preference

https://app-help.vectorworks.net/current/eng/index.htm?rhmapid=w_3DModeling
https://app-help.vectorworks.net/current/eng/index.htm?rhmapid=t_AttributeMappingTool
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Now that you know the types of geometry that are commonly used, along with some of the advantages and disadvantages, use these 

considerations when importing from other formats. 

Importing models from other CAD/BIM formats
More and more product manufacturers provide their products in various CAD/CAM/BIM formats. Many of these formats can be easily 

imported into Vectorworks, to then be “cleaned up” by applying standards for uniformity, aesthetics, and organization. 

CAD file sources - considerations

Here are some CAD file formats typically found as sources for models and notes on each type. If the option exists that more than one 

BIM/CAD format type is available, we highly recommend to test importing the different formats to see which resulting geometry provides the 

Are defined by control points. With NURBS it is more difficult to size 

the geometry accurately than with solids, but it does allow greater 

freedom for intricate model shapes. These are best suited for organic 

modeling.

Subdivisions

Provides better flexibility for creating irregular and complex forms. 

Difficult to use texture mapping.

 Preferred

Mesh and 3D Polysurfaces

Most imported geometry is available in this form, or it is converted to 

meshes during the importing into VW like from OBJ, 3DS, and certain 

DWG files. Meshes create larger files and longer rendering times. 

Grouped 3D Polygonal surfaces should be converted to mesh for 

applying textures and texture mapping if not already.

Mesh is typically unavoidable with many organic forms for plants, 

people, etc.

 less 

preferred

Experiment with using the Modify > Simplify Mesh… command 

in Vectorworks to see if the mesh triangulation can be reduced 

without losing too much detail.

Vectorworks has multiple direct import options available from the 

File>Import menu. 

There are many CAD/BIM models representing products in other 

CAD model formats. Here are some considerations for you on 

using other geometry sources and importing into Vectorworks.

Some of the more common formats will also allow the option 

to have it created within a symbol on import along with 

textures as well.

Import options under the File>Import menu
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best results.

Source: Revit Families

Revit is a common format for manufacturers who have products related to building construction and furnishings. Here are some 

observations when importing from this format:

 Method 1 - Recommended to most content creators with small collections wishing to convert to Vectorworks.

Import Revit files into Vectorworks. Go to File > Import > Import Revit…

This method produces heavier geometry and larger file sizes but still very usable geometry for most. 

It should also preserve image mapping/texturing resulting in Vectorworks textures being created and still mapped to the geometry.

This method is convenient for anyone to use.

This process is not used by Vectorworks.

:ve: Method 2 - This is only recommended for internal developers with Revit + Inventor + Vectorworks software. Summarized:

Best method for producing large collections/libraries of Vectorworks symbols. 

This is a more complex multi-import/export process that produces the best results but involves many  work arounds and tools.

We have found that if you are converting from another format to Vectorworks that models exported from Revit to ACIS/SAT format, and 

then imported to Vectorworks typically gives some of the best results. This assumes that the Revit geometry was created.

The caveat to this is that some SAT geometry created in new Revit features may not come in completely due to Vectorworks not using 

SAT natively for its geometry library. Parasolid geometry is Vectorworks' native format.

Import into a blank temporary file to isolate possible problems introduced during import.

We recommend creating a new file with the library template and then importing the cleaned-up resources into this. This will leave any 

extraneous content in the old file.  

Please note Revit materials are lost through this method.

This will be explained in more detail in a future BIM conversion workflow.

Source: AutoCAD DWG/DXF

If the DWG/DXF models are modeled with solids geometry then the imported result will generally be very good.

But if originally modeled with mesh, the results may not be as desirable. Typically you will get larger files and longer rendering time due to 

the number of polygonal faces composing the mesh object.

This often results in heavy mesh. We will typically remodel the geometry if that is the result.

Source: SketchUp

Sketchup generally provides very good results, and if textured the image mapping comes in typically without  problems and a texture 

resource is created through Vectorworks import.

Mesh geometry is often the result, with polygon numbers being low enough that minimum remodeling is needed.

Source: 3DS and OBJ

Generally, 3DS and OBJ formats will result in heavy mesh, but will bring in the image mapping as Vectorworks textures. 3DS import is 

generally only used when importing people and plant models with no other options. This will include the image mapping of the object that 

can be converted to a Vectorworks texture.

Please note for converting from Revit MEP that Vectorworks does not have a Revit Connector equivalent that is typically found in 

Revit MEP content.
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Source: Parasolid X_T 

Although this is our native geometry modeling kernel, it is not a format we have used for importing to build libraries. We think great results 

should be expected if that source format is available. 

After import

There are a few things to consider after importing files from other formats into your file.

Simplifying imported geometry

Imported models from other sources, like manufacturer’s CAD files, may be overly detailed. These may contain small details or parts that 

should be eliminated to simplify the geometry for design use (vs manufacturing purposes) in Vectorworks. This is typically a problem in files 

that come from CAD product design files. 

We recommend just importing model geometry into a file and doing your cleanup from there. Occasionally some extraneous (junk) 

objects can get introduced during the import/cleanup process.

After your objects are established and cleaned up, start a new file(s). Import the cleaned-up objects into the new file(s). Then 

organize and make that your final file for the symbols.

For imported geometry, ‘Remove By Class Settings' on the 

Attributes palette should be checked for and changed to 

None for the Fill, and Solid for the Pen. 

This will sometimes be changed to 'Class Style' when 

importing from other formats. This needs to be changed.

Attributes Palette

Example imported ceiling mounted light fixture with many details from manufacturer
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Geometry models like this should typically be simplified for use in Vectorworks as it will often be used as one of many other objects in a 

Vectorworks user’s design documents. All the internal parts are unnecessary for building large collections of products, for example.

When these models have a lot of multifaceted surfaces and complex details such as screw holes, fillets for corners, small bevels, radius, 

and heavy mesh, remodeling may be required.

Or if the models are from a source that results in complex meshes like from 3DS and OBJ sources, the geometry should be reduced or 

replaced.

As mentioned above in the, “Use the 3D Modeling features in Vectorworks” section, use Vectorworks functionality to replace geometry that 

is too large with simpler shapes like solids. 

Below are some options that can be used to simplify imported models. Overall, we try to lower most symbol object sizes to less than 3-4 MB 

per symbol. But there are exceptions especially with organic forms like plant models and very curved forms that are difficult to remodel and 

reduce.

Remodel geometry from import

You may find that it is better to remodel part or all of the model that has been imported. You can use the  imported model as a guide to 

rebuild a new version with improved geometry. Vectorworks developers often do this to reduce heavy geometry that makes the file size too 

large.

In the example below a heavy mesh object with many polygonal faces has been used as a guide to remodel it into a more usable and 

smaller 3D model. This is often done with imported lighting instruments.

By using the features mentioned in the section above “Use the 3D Modeling features in Vectorworks” a model can be reworked to have 

more efficient geometry.  

Simplify Mesh menu command

Complex mesh models may need to be simplified. The Modify > Simplify Mesh… menu command can help by reducing the number of 

polygon faces. Applying simplification will reduce polygons but can also affect the overall quality of the shape. Experiment with lowering the 

Example light instrument with dense mesh vs. light instrument 
remodeled in solids.

Most efficient geometry when well modeled 

and planned out.

Labor intensive to make.

Best overall performance with many 

instances

Advantages Disadvantages
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polygon faces to see if a good balance of aesthetics and lowering size can be achieved. Overall lowering the polygons in mesh will reduce 

the file size and regeneration time.

Using the Subdivision tool

The Subdivision tool can be used to create or replace all or part of the geometry. This tool is more free form and can allow more difficult 

shapes to be modeled easier. Here are some tips to follow:

If you set the subdivision to 1 this will create too few subdivision mesh faces which is equivalent to polygon modeling.

Increasing the subdivision iteration to 3 will create 64 subdivision mesh faces per cage face. 

See the figure below which shows subdivision iterations from 1 to 4 for comparison. Integration 1 is too low and integration 4 is too high. 

Choosing integration 2 or 3 provides a good balance for simplifying polygon numbers.

Example textured vase model with varying results from using the Simplify Mesh 
command.

Can greatly reduce the number of polygon 

faces.

May lose some of the needed form if it is 

overdone.

Reduced model size. Texture image mapping can get weird 

looking.

Requires “trial and error” experimenting 

with polygon number.

Advantages Disadvantages

Choosing a Subdivision iteration in the middle (2 and 3) is a better balance.

Advantages Disadvantages
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Remove geometry history (optional)

Solid operations created using commands such as Add Solid, Subtract Solid, Create Subdivisions Primitive, and tools like the Fillet Edge, 

Chamfer Edge, Shell Solid, and Edit Subdivision, will retain editing history in the object. 

:ve: The history can be removed by using the File > Convert > Convert to Generic Solids menu command. This will often reduce the file size; 

however the object is no longer editable. Make sure your edits are final before doing this command. You may want to create copies of your 

symbol if you think it will be revisited at a future date.

This method should be used knowing that once performed the geometry will no longer be editable.

It should also be tested to see if the model did reduce the file size. Sometimes it may make the file size larger, as in with extrude and 

sweep solid operations.

Can control the polygon faces More faces make its properties much like 

mesh. 

Makes complex forms

Can convert be converted to Solids/NURBS. 
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3D/Hybrids and Symbol Options
Being familar with the symbol options is important for any type of symbol setup and planning how the symbol will be placed into the 

Vectorworks document. 

3D/Hybrid symbols, which combine both 2D and 3D geometry within a symbol, will require proper arrangement that also relates to the 

proper setup and placement using Symbol Options. 

This section will explain setting up the Symbol Options and creating 3d/Hybrid symbols.

Making a 3D/Hybrid
Now that you have an understanding about the 2D and 3D symbol geometry, there is another type of symbol, the 3D Hybrid. To make this 

work correctly both the 2D and 3D geometry should be aligned on the X and Y axis when the symbol is created or when editing an existing 

symbol and adding one object with the other. 

Relation of 2D and 3D geometry for insertion

Insertion points should be planned so that when placed, a minimum effort or no effort is needed in adjusting the position of the symbol in 

relation to other objects and the layer plane. 2D symbols will only need an “X” and “Y” position established, but 3d will need the “Z” value 

position considered as well. Hybrid symbols will need to have the 2D object’s insertion point (usually from a top, plan view) match the 

insertion of the 3D object from the same planar view or position that the 2D object represents.

For example, this toilet below has a required distance for installation from the wall. Both the 2D plan and 3D top are at the same position 

and distance relative to the insert point. The 3D’s “Z” value is at zero, so when it is placed the bottom of the symbol will be at the floor which 

is the “0” height “Z”.

This way when a standard view (View > Standard Views > ...)   in Vectorworks is selected to switch between Top/Plan and the Top 3D view, 

both the 2D object and 3D will align.

Insertion Point Placement

Locus points

Locus points are not typically left in symbols, but in certain cases there is a need for them.

If a symbol is to have other parts attached to it, then a locus may be needed to specify the correct location for placement as demonstrated in 

this sink and faucet example.

The sink symbol on the left has had locus points added for snapping separate faucet symbols to it to create a greater assembly.

2D Planar Top/Plan view 3D model Front view 3D model Front view
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Locus points can also be used to designate the size of the break in a wall for symbols that are used in wall insertion. On the face of this 

example fireplace there is a locus point on each of the four corners that determines the opening size when placed in a wall break.

 Locus points for wall breaks

Detailed insertion placement

For more specific information about the insertion point placement for specific categories of objects see the Appendix on Insertion Point 

Rules.    

:ve: This is for Vectorworks internal and may be more detail than someone just creating symbol models may care to know. 

Appendix - Insertion Point Rules

Symbol Options
Every symbol has symbol options that need to be set up for optimal use depending on the symbol's use and purpose. Below is more 

information on how we set this up. For more information also consult the Vectorworks Help system.

Locus points in a symbol for placement attachment symbols

https://vectorworks.atlassian.net/wiki/spaces/CBH/pages/3690889266
https://vectorworks.atlassian.net/wiki/spaces/CBH/pages/3690889266
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Units

Most symbols should be World-based except special symbols meant for annotation on Sheet layers. 

Story-aware

Checking the Story-aware box allows the symbol placement to interact with the Stories elevation feature. 

Insertion in walls

Developer discretion needs to be used depending on how the symbol should interact with the wall and if it should break the wall in Top/Plan 

view. 

Most symbols can have this unchecked unless it is meant to be inserted into a wall like for a door or window object.

Other options - Convert to group

This creates a blue symbol that will no longer be a symbol once it is placed into the document. It converts to a group and any records will 

also be lost using this option. 

VW2024 Symbol Options dialog box

:ve: BIM/AEC content will typically use this when we want to work with the standard 

story levels in the standard Architect templates. 

This may include some Landmark content that can be used in and around 

buildings. 

Story-aware setup is unnecessary for most content creators.

Story levels are present in the default Architect, Blank, and Landmark templates that are accessed when creating a new document. 

File > New… menu
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This option is used for objects that are created to be further modified. For example, profile shapes for extrusion where a symbol container is 

not needed once added to the document.

Other options - Assign to class

This provides a “container” class for the entire symbol. This can be used to control the placement of the symbol in a document. 

When the class is made invisible later, you do not see the symbol(s) assigned to that class.

How to add classes to your file

This explains how to add Vectorworks standard classes to the file where you are developing your models in.

:ve: Vectorworks developers typically have the symbols insertion options set up to 

place the symbols in one of the classes from the default set of classes if for 

Architect and Landmark product use.

This rule is generally not applied to the Spotlight product content.

For 3rd party creators having classes set for insertion is optional and leaving set 

to <Active Class> is recommended

Vectorworks classes vs. layers

Classes and Layers can be seen in the Organization dialog box and Navigation palette (Design Suite product required).

Vectorworks Classes - are comparable to layers found in AutoCAD and Rhinoceros.

Vectorworks Design Layers - are a working space where all modeling is done.

Vectorworks Sheet layers - are for presentation and printing.

Classes will be all you need to consider when making a library of symbols.

:ve:  Vectorworks uses a set of predefined classes in its library files. 

These default classes can be accessed from the Navigation palette, 

by selecting the Classes tab, and then right clicking in the spaces 

where the classes are listed. Select, New…

This opens the New Class dialog box. Select the Import Classes 

radio button, and select “VW Arch (Imperial).sta” from the drop 

down.  

Classes are added to the symbols as an Insertion Option, which will 

be explained below.

 As mentioned above for Content Creators, the use of classes is 

optional. 

Future guides will provide recommendations on class use in 

specific workflows.

New Class dialog box
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Spotlight entertainment specific libraries

Spotlight has its own unique classes for the content that is applied to geometry parts and not the symbol’s container class as described 

above. These are found in the Spotlight templates.

Architectural and Landmark BIM libraries

More explanation of the classes for BIM content may be provided in a future BIM conversion guide.

Cut Planes settings

The Cut Plane settings are described in detail in the Appendix of the Basic Guide. This is a more complex setting.

Appendix - Cut Plane Settings for Symbols

Vectorworks developers typically apply this for many symbols libraries.

For 3rd party creators this can more than likely be omitted from your workflow.

https://vectorworks.atlassian.net/wiki/spaces/CBH/pages/3127115837
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Renderworks Textures
Symbol parts can have Renderworks Textures (texture) attached to improve the presentation, and provide a more realistic look for 3D 

geometry.

As shown in the section discussing the 3D grouping, you may need to break up and arrange your geometry so separate textures can be 

applied to achieve your desired look.

All geometry should look aesthetically pleasing in 2D and 3D.  For the 3D it should look good in Shaded rendering mode, and if textures are 

to be applied, they should look even better when rendered in Final Quality Renderworks rendering mode.

Texture shader options
Below are some of the shaders we more commonly use in our textures in the VW Libraries. There are many others that are not covered 

here. For more information on the textures please read the Vectorworks Help system’s section on Creating Textures in the “Presenting the 

project” section.

Make image based textures

Most of the textures that Vectorworks provides are image based textures. Images should only be JPG or PNG images. These textures use 

the Image shader in the Shaders > Color field of the Edit Texture dialog box.

Considerations
We recommend that these images are no more than 1 megapixel in size. For example 1024x1024 pixels would be standard 1mp size of 

many images sizes. Larger images will make for very large textures and thus increase files size when nested/applied to the geometry. 

This will be unnecessary since most images in textures are made to repeat or tesselate.

If your source image maps that are imported and become Vectorworks textures, are too large, consider reducing the image size. 

 Sometimes images may need to be used that entirely cover the object and cannot or should not tesselate. See the Direct Texture 

Mapping example below. 

An image can tessellate but may not be square. For example, a wood texture that is meant to show the long wood grain.

Direct texture mapping 

As mentioned in the 3d symbols section of this guide, image base textures can also be used with the Attribute Mapping tool to apply images 

instead of detailed modeling. It is a great option to map an image on the surface of an object. Make sure the textures are an adequate size, 

so you won’t lose quality if it is meant for closer viewing. Refer to the Help system for more information.

 Vectorworks Help - Direct texture mapping 

1024x1024 image is all that is 
typically needed

https://app-help.vectorworks.net/current/eng/index.htm?rhmapid=d_RunChooseShader
https://app-help.vectorworks.net/current/eng/index.htm?rhmapid=t_AttributeMappingTool
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Using the Object Attribute shader texture

Rather than making a lot of textures that use the Texture’s Color shader to represent each of the colors be numerous, we may use the Obj 

Attribute shader. This will use the color fill of the object instead of the texture’s Color shader. Then we apply shaders such as reflectivity 

and/or bump maps to an object, rather than needing to create separate color textures for each color needed.

Applying a texture using the Obj. Attribute shader like this allows the color fill to be easily changed vs. making many individual textures. 

This can be very useful after importing many models from another format, like SketchUp, where each color may become its own texture. 

Replacing many textures with just one texture for a finish type (e.g. paint), can save a lot of space and make parts easier to edit the fill color, 

later.  

Obj Attribute color shader
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Changing the color fill is easy on this car body while retaining the same paint sheen by using a texture that uses the Obj Attribute shader. 

The object can now be selected and have its fill changed to another color without having to go back and edit the texture. This single texture 

can be used across many models with different color variations.

Reflectivity

Reflectivity is a commonly used shader like in the car example above. This shader is used for creating shiny objects or surfaces that have 

reflective surfaces. It is often used for plastic, glass, cloth, and metallic surfaces. It is also used to provide glow and light emitting effects.

Bump mapping

When bump mapping is added to a texture it is usually image based from another source “color” image. 

The benefit is the 3D effect created in showing relief such as bumps, grooves, or scratches on an object. This provides a nice effect for 

bricks, wood grains, and scratches in metal surfaces.

Bump mapping is not used a lot, as we find there is a performance and file size penalty when building large collections of textured objects 

with bump maps applied. It is better reserved for final presentation effects and not more general rendering.

Transparency

This shader specifies how opaque or transparent the object is. This will affect how light shows through an object, such as through window 

glass, plastic and glass bottles, and water. A mask with alpha channel can also be used with this shader. 

Car body with Obj Attribute shader texture applied.
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In the example above the mask will have opaque areas with transparent areas where the holes appear.

For more information on texture shaders see the Help: Renderworks shader parameters  

Surface hatch textures

:ve: Surface hatches are only applied for certain textures. We do not typically use it on 3D models in symbols. Instead, it is mostly used for 

textures to be applied to certain plug-in object styles, usually with components. This would include plug-in styles like walls, slabs, roof, and 

hardscape styles.

 This is likely rarely needed for most Content Creators, but it is good to know.

Setup

The surface hatch used in textures provides an additional presentation visual when the rendering is set to Hidden Line rendering. 

Transparency shader with Image Mask

Textured Wall Styles in Shaded rendering. Textured Wall Styles in Hidden Line rendering 
displaying Surface Hatches.

https://app-help.vectorworks.net/2024/eng/VW2024_Guide/Textures/Renderworks_shader_parameters.htm?rhsearch=shaders&rhhlterm=shader%20shaders
https://app-help.vectorworks.net/2024/eng/VW2024_Guide/Textures/Renderworks_shader_parameters.htm?rhsearch=shaders&rhhlterm=shader%20shaders
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Textures in the Vectorworks Libraries
We recommend that everyone keep the Resource Manager up to date by accepting the update when first opening Vectorworks so you have 

all the content available. This will update the underlying catalog/database to correctly display the latest version of the content. 

 For the textures, you can then make use of all the textures in the libraries as many are online and not in the application as indicated by a 

cloud on the file icon in the Resource Manager.

In the image below, an object is selected, which has had a texture applied from the Object Info palette. The first texture file listed, in the 

Resource Selector, shows the “basic set called” _Textures.vwx containing examples of various subjects of textures. This is followed by a 

deeper collection organized by subject in many files that follow.

Edit Texture dialog using Surface hatch, and on the right, the edit dialog box for the surface hatch
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By accessing these files, you can see how Vectorworks has built its texture collection. 

Texture resource organization 

Nomenclature

:ve: Most Vectorworks textures have a one word prefix to show its main subject or category. This is followed by some simple description, 

and it always has a “RT” suffix to identify the resource type. This suffix is added because there can be very similar names for hatches (HF 

suffix), image fills (IF), tile fills (TF) and material (MT) resources that represent real world materials. All have a two letter suffix to easily 

distinguish them.

Symbols don’t typically have a suffix to identify the resource type because it is the most common resource in the Vectorworks libraries.

Object with texture applied from the Object Info palette.

Here is an example of a texture nomenclature break-down. Texture 

name:

 Brick Modular Running Bond <Surf Hatch> RT

Looking at the table below you can see how its name is derived 

with four different parts to name the texture resource. This includes:

Prefix Category.

Description with as few words as possible.

Special suffix - only for special cases like pointing out special 

use texture shaders.

Resource Type identifier
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 Content creators can use whatever nomenclature they wish.

Texture organization in symbol files

:ve:  When there are textures nested in a symbols collection, a resource folder will be created to hold the textures. This separates the main 

subject from supportive (nested) content.

Providing a resource folder like this is similarly repeated when other support resources are present like, Line Types, Hatch Fills, Tile Fills, 

etc.

What about materials with textures?
We do not cover the material resources in the Basic Guide. Since most of this guide is related to standard 3D symbols, we just recommend 

using textures to represent your object’s finishes. It is not usually necessary for symbols to have materials applied.

Materials are a much more complex setup combining multiple resources (i.e. surface hatch textures, hatch fills), assigning classification, 

providing real world physical property data, and requires planning its usage with various objects. It is therefore not covered here in the Basic 

Guide. A section may be added on this topic at a future date.

Texture with surface hatching

Brick Modular Running Bond <Surf Hatch>

Identifies this as using a 

surface hatch for hidden line 

rendering.

RT

Abbreviation for 

Renderworks Texture.

Prefix Category Description Special suffix (special 

case)

Resource type 

identifier

Texture folder separates main subject content.
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Finishing the Library
Once the library of resources is complete, it should be presented in a file, or collection of files, in a consistent manner. There are a few steps 

to take to refine your presentation.

:ve: Vectorworks developers should also consult our ‘Library Development Checklist’.

Clean up the library

Remove extraneous objects

From the View bar, go to the Zoom group, and select Fit all objects. This can help identify extraneous geometry lying outside your view, if it 

is present. If any is found, delete it. 

Also run, Select All, Ctrl+A or Cmd+A to select any objects and if there are any on the Object Info Palette.

Purge it out

Files should be purged carefully!

Vectorworks will purge (Tool > Purge…) anything not placed into the document. You should review the dialog and deselect resources that 

should not be removed. There may be junk classes, layers, and objects to remove. 

Start fresh with a new file

Or create a new file from one of the Blank (unit).sta files and import all the resources you have created into a “clean” file. This is a good way 

to leave all the junk behind by just selecting the resources you need and then importing them into the new file.

We recommend to never make the files too large. Most Vectorworks developed library files are around 25 - 50 MB because most are 

provided via download from the cloud. 

Setting RM Previews
For any collection it is best to have all the symbol's thumbnails shown in the same view and with the same rendering mode. The example 

below shows the smaller thumbnails in “Hidden Line” for the Thumbnail Rendering Mode for a cleaner look than the other two options (Wire 

Frame and Shaded) would give in this instance. 

In the large Hi Res Previews, all symbols use the Shaded rendering and provide another view than what the thumbnails show. This will 

provide a nice comparison of hidden line and shaded rendering.

To change this, select all of the symbols and right click to set the Thumbnail and Hi Res Preview, Views and Render Mode. 
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Since this is a symbols library of products, the texture resources have been collected in a resource folder, because it is not the main subject 

of this example library.

Congratulations! You have created a collection of Vectorworks resources!

A collection of Knoll brand files with the resources well presented
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Appendix - Insertion Point Rules
This appendix adds the general rules for the insertion points and arranging your geometry in relation to the “0” coordinate X, Y, Z location 

when editing a symbol. Exceptions apply.

Insertion point rules
Please note: This is subject to change for plug-in/feature changes in Vectorworks.

Please remember that 3D/Hybrid symbol need both the 2D and 3d geometry aligned on the X and Y axis

Sanitary/Plumbing fixtures

Sink, 

Foodservice 

sink assembly

X, Y axis back center (typically), X, Y 

axis back corner (alternatively), Z at 

floor (base)

0 yes F.F. no n/a no

Sink, top mount 

drop-in 

(lavatory, 

kitchen, etc.)

X, Y axis back center, Z at base of 

rim where it meets the countertop

rim bottom at 0 Z no n/a no n/a no

Sink, 

undermount 

(lavatory, 

kitchen, etc.)

X, Y axis back center, or on drain 

center for odd shape sink. Z height at 

top of rim where it meets the 

countertop bottom

rim top at 0 Z no n/a no n/a no

Sink, 

vessel/vanity 

bowl

X, Y axis drain center or center 

overall, Z at bottom base of sink, 

where it meets the countertop

see spec sheet or 

standard vanity 

height

no n/a no n/a no

Sink single or 

trough, wall 

mount

X, Y axis back center, Z at top of 

sink.

see spec sheet 

for mounting 

point height. 

yes F.F. yes on edge no

lavatory 

sink/pedestal 

combo

X, Y axis, at center back, Z at base.  0 yes F.F. yes on edge no

lavatory 

sink/pedestal 

top only

X, Y axis at center back, Z at sink rim 

(refer to mnfr spec sheet) .

see spec sheet  yes F.F. yes on edge no

pedestal full 

height (part 

only)

X, Y, at center back and bottom.  The 

user will need to adjust position from 

the wall.

0 yes F.F. no n/a no

pedestal (semi) 

apron only (part)

X, Y, at center back and top so it can 

be mounted to a pedestal sink 

see spec sheet  yes F.F. no n/a no

Type of 
symbol: main 

object (parent) 

symbol, part 

(child) symbol,

3d insert location (0,0,0) - 
description below is based on the 

front of the object facing the bottom 

of the screen, when viewed from 

top/plan in VW.

Geometry Z 
height

in symbol

Story 
Aware

Z 
Reference

Insert 
in 

Walls

wall 
locatio

n

Wall 
Breaks
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bottom. The user will need to adjust 

position from wall.

toilet base, floor 

mount

X, Y axis is at center back offset from 

wall (see spec. sheet), Z at base.  

0 yes F.F. yes on edge no

toilet base, wall 

mount

X, Y axis is at center back on wall 

(see spec. sheet), Z at base.  

see spec sheet  yes F.F. yes on edge no

toilet cisterns 

(part)

X, Y axis is at center back on wall 

(see spec. sheet), Z at base.  

see spec sheet  yes F.F. varies on edge no

toilet seat/cover 

(part)

X, Y axis is on mounting point to 

snap to parent locus point (at front), 

Z at base

0 no n/a no

urinals X,Y axis at back center where it 

mounts to wall, Z at urinal bottom 

see spec sheet  yes F.F. yes on edge no

bidets, floor 

mount

X, Y axis is at center back offset from 

wall (see mnfr. spec. sheet), Z at 

base.  

0 yes F.F. yes on edge no

bidets, wall 

mount

X,Y center point where it mounts to 

fixture, Z at  

see spec sheet  yes F.F. yes on edge no

ptrap (part) X, Y axis center point where it 

mounts to parent fixture, Z at top

0 no n/a no

toilet/urinal valve 

(part)

X, Y axis center point where it 

mounts to parent fixture, Z at bottom

0 yes F.F. no

tub/whirlpool 

alcove

X, Y axis back left corner, Z at base 

where it meets floor

0 yes F.F. yes on edge no

tub/whirlpool top 

mount drop-in 

X, Y axis center, center, Z at base of 

rim where it meets the object it insert 

into

"0" to adjust by 

user

no n/a no on edge no

tub/whirlpool 

free standing 

(claw foot tub)

X, Y axis center, center, Z at bottom 

where it meets floor

"0" to adjust by 

user

yes F.F. no on edge no

Shower 

pan/base

X, Y axis back corner, Z at base 

where it meets floor

0 yes F.F. yes on edge no

faucet/taps/mixe

r - wall mounted

X,Y center back point where it 

mounts to the wall, Z at connection 

centerline.  

0 no n/a yes on edge no

faucet/taps/mixe

r - base or sink 

mounted

X,Y center point of center faucet, 

where it mounts to a parent fixture 

(sink, or counter), Z at base  

0 no n/a no n/a no

Showerheads, 

part

Varies based on where you want it 

snapped to other parts 

0 no n/a no n/a no

Showerheads 

ceiling mount

X, Y center and Z at top 0 yes Ceiling no n/a no
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Shower/tub 

faucet 

assembly/comb

o

X,Y center back point where it 

mounts to the wall,  Z bath spigot 

centerline  

see spec sheet  yes F.F. yes on edge no

Appliances 

Major 

appliances, floor 

standing

X, Y axis, back left corner, Z at base 

where it meets floor

yes F.F. no

Major 

appliances, 

cabinet insert - 

wall oven, 

microwave

X, Y axis, back left corner, Z at base 

where it snaps to adjoing cabinet, 

furniture, etc.

yes F.F. no

Range hood 

w/chimney

X, Y axis, back center, Z at top where 

it meets ceiling 

yes F.F. no

Countertop 

appliances

X, Y axis, back left corner, Z at base yes F.F. no

Electronics 

(devices, 

audio/video 

components)

X, Y axis, back left corner, Z at base yes F.F. no

Furnishings 

Furniture/furnish

ings

Typically, if it may be referenced 

when place from a wall corner, the x, 

y insert should be on the objects 

corner.

tables, desk, 

sofa, modular 

furniture 

intended to be 

put together with 

other symbols

X, Y axis, back left corner, Z at base 

where it meets floor.

yes no n/a no

desk chair, 

round table, 

table and chair 

combo set

X, Y axis, center, Z at base where it 

meets floor

yes no n/a no

systems 

furniture

main "assembly" symbol should be 

on a corner where it can be snapped 

to another systems furniture 

configurations

yes no n/a no

wall mount 

objects: 

shelving/pictures

/

X, Y axis, back left corner yes no
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Cabinetry style 

object

X, Y axis, back left corner, Z at base 

where it meets floor.

yes on edge no

Fireplace style 

object

X, Y axis, front left corner yes on edge no

Sprinklers 

(ceiling mount)

yes Ceiling yes on edge no

Sprinklers (wall 

mount)

no yes on edge no

Lighting fixtures 

wall recessed 

mounted

varies yes F.F. yes edge no

wall surface 

mounted

varies yes F.F. yes edge no

ceiling surface 

mounted

0 yes Ceiling no n/a no

ceiling recessed 

mounted

0 yes Ceiling no n/a no
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Appendix - Cut Plane Settings for Symbols
Introduction
Beginning in Vectorworks 2020 we started adding cut plane settings to symbols and plug-in objects. This allows objects that are typically 

never cut, to automatically show as uncut when passing through the cut plane of a section viewport. 

Horizontal and vertical section settings
The following table below is for selecting which horizontal and vertical section setting to apply to plug-in objects and black symbols.

dash = View as Cut when Cut 
in Viewport 

Uncut below = View as Uncut 

below when Cut in Viewport 

Uncut above = View as Uncut 

above when Cut in Viewport

dash = View as Cut when Cut in 
Viewport 

Uncut beyond = View as Uncut beyond 

when Cut in Viewport 

Uncut before = View as Uncut before 

when Cut in Viewport

Bath-Shower Uncut below -

Base Cabinet Uncut below -

Ceiling Grid - -

Clothes Rod Uncut below 

(to show the PIOs 2D Top 

component)

-

Compartment Sink Uncut below Uncut beyond

Counter Top Uncut below -

Desk Uncut below Uncut beyond

Fireplace* - -

Grab Bars Uncut below -

MEP – Circuiting Uncut below -

MEP – Receptacle Uncut below -

MEP – Comm Device Uncut below -

MEP – Incandescent Fixture Uncut below -

MEP – Switch Uncut below -

MEP – Piping Uncut below -

MEP – Piping Connection Uncut below -

MEP – Piping Run Uncut below -

MEP – HVAC Damper - -

MEP – HVAC Diffuser - -

Plug-in Object Horizontal Section Vertical Section
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MEP – HVAC Elbow Duct - -

MEP – HVAC Flex Duct - -

MEP – HVAC Outlet - -

MEP – HVAC Splitter - -

MEP – HVAC Straight Duct - -

MEP – HVAC Transition - -

MEP – HVAC Vertical Duct - -

MEP – HVAC Vertical Elbow - -

Plant Uncut below Uncut beyond

Seating Section Uncut below -

Shelving Unit Uncut below Uncut beyond

Table and Chairs Uncut below Uncut beyond

Toilet Stall Uncut below -

Utility Cabinet Uncut below -

Wall Cabinet Uncut above -

Workstation Counter Uncut below Uncut beyond

Workstation Overhead Uncut above Uncut beyond

Workstation Panel Uncut below Uncut beyond

Workstation Pedestal Uncut below Uncut beyond

dash = View as Cut when Cut 

in Viewport 
Uncut below = View as Uncut 

below when Cut in Viewport 

Uncut above = View as Uncut 

above when Cut in Viewport

dash = View as Cut when Cut in 

Viewport 
Uncut beyond = View as Uncut 

beyond when Cut in Viewport 

Uncut before = View as Uncut before 

when Cut in Viewport

Appliance - Water Heaters Uncut below Uncut beyond

Appliance - 

Refrigerators and Freezers

Uncut below Uncut beyond

Appliance - Hoods - -

Appliance - 

Clothes Washers and Dryers

Uncut below Uncut beyond

Appliance - Wall Ovens Uncut below Uncut beyond

Category - Architectural/Interior Horizontal Section Vertical Section
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Ceiling Fans - Uncut beyond

Electrical Devices and Panels 

( Libraries/Objects - Building Services/Electrical/ )

Uncut below -

Equipment - Shelving and Racks 

(floor standing)

Uncut below Uncut beyond

Furniture Uncut below Uncut beyond

Modular Workstation Assemblies - -

Light Fixtures - 

Ceiling Mounted and Suspended

- Uncut beyond

Light Fixtures - Wall Mounted Uncut Below Uncut beyond

Light Fixtures - 

Floor and Table Lamps

Uncut below Uncut beyond

Fire Extinguishers and Extinguishers Cases Uncut below Uncut beyond

Plumbing Fixtures - 

All except Shower Heads

Uncut below Uncut beyond

Plumbing Fixtures - Shower Heads - Uncut beyond

Entourage - Vehicles Uncut below Uncut beyond

Entourage - People 3D Image Props Uncut below Uncut beyond

dash = View as Cut when Cut in Viewport 
Uncut below = View as Uncut below when 

Cut in Viewport 

Uncut above = View as Uncut above when 

Cut in Viewport

dash = View as Cut when Cut in Viewport 
Uncut beyond = View as Uncut beyond when 

Cut in Viewport 

Uncut before = View as Uncut before when 

Cut in Viewport

Audio Uncut below Uncut beyond

Bumpers Uncut below Uncut beyond

Microphones Uncut below Uncut beyond

Panels, Acoustical - -

Speakers, Professional Uncut below Uncut beyond

Controls - Audio, Lighting, Video Uncut below Uncut beyond

Event, most objects Uncut below Uncut beyond

Event, Tents Uncut below Uncut beyond

Ent Stage folder (all objects) Uncut below Uncut beyond

Ent Lighting Instruments objects Uncut below Uncut beyond

Category - Entertainment Horizontal Section Vertical Section
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Truss - -

dash = View as Cut when Cut in Viewport 

Uncut below = View as Uncut below when 

Cut in Viewport 

Uncut above = View as Uncut above when 

Cut in Viewport

dash = View as Cut when Cut in Viewport 

Uncut beyond = View as Uncut beyond when 

Cut in Viewport 

Uncut before = View as Uncut before when 

Cut in Viewport

Furniture/Furnishings Uncut below Uncut beyond

Transit Stops Uncut below Uncut beyond

Outdoor Lighting Uncut below Uncut beyond

Landscape Site objects Uncut below Uncut beyond

Category - Landscape Horizontal Section Vertical Section
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